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1 Introduction 

1.1 Objectives 
This protocol describes how to: 

• Produce and purify recombinant human and mouse α-synuclein in monomeric form from 
transformed bacteria 

• Generate α-synuclein preformed fibrils (PFFs) from recombinant monomeric α-synuclein 
• Fluorescently label α-synuclein PFFs 

1.2 Protocol Overview 
Using conventional methods for bacterial transformation and large-scale protein expression, 
plasmids containing glutathione S-transferase (GST)–tagged full-length recombinant human 
(NM_000345) or mouse (NM_001042451) α-synuclein are expressed in BL21 (DE3) 
Escherichia coli (Figure 1). In parallel, a plasmid containing GST-tagged recombinant 3C 
enzyme, which is capable of cleaving the GST tag from GST-tagged proteins, is also expressed. 
The GST-tagged proteins are purified from the bacterial cell lysates by affinity column 
chromatography. 

The purified GST-α-synuclein protein is treated with GST-3C enzyme to remove the GST tag. 
Untagged α-synuclein protein is purified from the reaction using affinity column chromatography 
and then further purified using size exclusion chromatography. 

The recombinant monomeric α-synuclein protein can be used for experiments directly, or for 
generating PFFs through aggregation. PFFs can then be fluorescently labelled if desired, 
depending on the experiment.

 

Figure 1. Protocol overview for the expression and purification of GST-tagged α-synuclein (GST-α-syn) and 
3C enzyme (GST-3C), cleavage of GST tags and purification of untagged α-synuclein, and generation of α-
synuclein PFFs. 
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Untagged α-synuclein protein (monomeric form) should be tested for bacterial endotoxin to 
ensure that levels are below the threshold for the endotoxic response in mice and human cells. 
Note that some animal species have a lower threshold for the endotoxic response and can only 
tolerate proteins produced in bacterial strains with a disabled endotoxin signal (e.g. ClearColi 
bacteria must be used to produce α-synuclein for marmosets). 

 

1.3 List of updates from previous versions of the protocol 
• Centrifuging speed was adjusted (page 14) 
• Volume of cold wash buffer to be used was changed (page 14) 
• The volume of sample to be loaded in the SDS mini gel was corrected (pages 14 and 16) 
• PBS to replace cold wash buffer to wash the column (page 16) 
• Updated sequence of inserts (pages 21 and 22) 
 

 

1.4 Technical and safety considerations 
The following information should be read before starting: 

• All material and reagents should be sterile or autoclaved: 

– Glass flasks should be capped with aluminum foil and autoclaved to sterilize. 
– Lysogeny broth (LB) medium should be autoclaved on the liquid cycle for 30 minutes 

exposure time at 121°C to sterilize. After autoclaving, cool LB medium to room 
temperature before using. 

• Use sterile technique and work over a flame during procedures involving bacterial cells and 
cultures. 

• During the first procedure of expressing and purifying the GST-tagged proteins (section 3.1), 
it is possible to pause prior to sonication of the bacterial culture. 

• Following purification of the GST-tagged proteins (section 3.1), it is necessary to proceed 
directly to the cleavage reaction (section 3.2). The purified GST-tagged proteins are sensitive 
to degradation should not be stored to perform cleavage reaction at a later time. 

• All users of the ÄKTA pure protein purification system must be trained. The Superdex 200 
16/600 columns should be used with care following proper training. 

• All users of the Bioruptor Plus sonication device and water cooler must be trained. 
• While working with α-synuclein PFFs: 

– Wear appropriate personal protective equipment at all times, including disposable gloves, 
a laboratory coat, a face mask, and protective goggles. 

– Perform all procedures in a sterile Class II biosafety (BSLII) cabinet. 
– Avoid inhaling PFFs or getting aerosolized PFFs in eyes. 
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• After working with α-synuclein PFFs: 

– Clean area with 1% SDS to destroy fibrils, then rinse area with sterile distilled water. 
– Dispose of all tips and tubes into a large empty bottle or a 50-mL tube containing 1% 

SDS. Store items in 1% SDS for up to 2 hours to disassemble the PFFs. 
– Dispose of gloves and face mask in an autoclavable biohazard bag to be sterilized. 

• For further information on the use of SDS to break down α-synuclein PFFs, refer to Bousset 
et al. 2016. J. Parkinson Dis. (6) 143–151. 

• Store α-synuclein PFFs at –80°C and thaw at room temperature. Do not store PFFs on ice or 
at 4 °C, as this causes dissociation and reduces activity. Avoid repeated freeze-thaw cycles. 

• Do not vortex α-synuclein PFFs. 
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2 Materials 

The material, reagents, and equipment listed in this document can be substituted for those 
supplied by other manufacturers. However, the performance of the assay may not be the same 
and may need to be optimized or redeveloped upon significant modifications to the materials 
and/or methods. 

Refer to the product data sheet from the supplier for further details on storage and preparation 
instructions. 

2.1 Labware 
Item Supplier Catalogue # 
Sterile needle, 22G 1½" Becton Dickinson 305156 
Aluminum foil Sigma Aldrich Z185140 
Amicon Ultra-15 Centrifugal 
filter unit 

Millipore UFC900324 

Autoclave tape Fisher Scientific 15903 
Chromatography columns, 
10-mL, disposable (with 
stopcocks)* 

Thermo Scientific 29924 

Chromatography columns, 
20-mL, disposable (with 
stopcocks)* 

BioRad 732-1000 

Column holder Fisher Scientific 22-036466 
Cryovial Fisher Scientific 50-873-794 
Erlenmeyer flask, glass, 125-
mL 

Sigma Aldrich CLS4980125 

Erlenmeyer flask, glass, 2-L Fisher Scientific FB5002000 
Glass bottle with cap, 1-L Fisher Scientific C13951L 
GSTrap 4B GE Healthcare Life Sciences 28401745 
Mini-PROTEAN® Tetra cell BioRad 1658004 
Mini-PROTEAN® Tetra cell 
casting module 

BioRad 1658021 

Parafilm Sigma Aldrich P7793 
Petri dish, 100 mm x 15 mm Fisher Scientific FB0875712 
Plate, 96 deepwell Eppendorf 0030504305 
Plate, 96-well, clear BD Falcon 351172 
Polypropylene bottles, 500-
mL 

Beckman Coulter 361691 

Polypropylene bottles, 50-mL Beckman Coulter 361694 
Slide-A-Lyzer™ MINI Dialysis 
Device, 3.5K MWCO, 0.5 mL 

ThermoFisher Scientific 88400 

Spectrophotometer cuvette Sigma Aldrich C5416 
Sterile disposable filter unit, 
0.2-µm 

ThermoFisher Scientific 566-0020 

Sterile syringe filter, 0.2-µm VWR 28145-501 
Sterile syringe, 10-mL Becton Dickinson 309604 
Sterile syringe, 1-mL Becton Dickinson 309628 
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Item Supplier Catalogue # 
Superdex 200 16/600 column GE Healthcare Life Sciences 28-9893-35 
Support stand Fisher Scientific 22-260469 
Tubes, 50-mL Fisher Scientific 14-959-49A 
*Reusable chromatography columns may be used as an alternative to disposable columns (e.g. 50-mL 
reusable chromatography columns [Bio-Rad Laboratories #7374251]). 

 

2.2 Reagents 
Item Supplier Catalogue 

# 
Stock 
conc. 

Working 
conc. 

Storage 
temp. 

Acetic Acid, 
Glacial (Certified 
ACS) 

Fisher 
Scientific 

A38-450LB 100% Various RT 

Acrylamide/ 
bisacrylamide 
(29:1), 30% 

BioRad 1610156 30% Various 4°C 

Agar BioShop AGA001 NA 15 g/L RT 
Alexa Fluor™ 
488* 

Molecular 
Probes 

A20000 5 mg/mL ~161 μg/mL Stock:  
–20°C 

Alexa Fluor™ 
568* 

Molecular 
Probes 

A20003 5 mg/mL ~161 μg/mL Stock:  
–20°C 

Alexa Fluor™ 
633* 

Molecular 
Probes 

A20005 5 mg/mL ~161 μg/mL Stock:  
–20°C 

Ammonium 
persulphate 
(APS) 

Sigma Aldrich A3678 10% 0.005% RT 

Ampicillin Sigma Aldrich A9393 100 mg/mL 100 μg/mL  Stock:  
–20°C 
Working: 4°C 

Aprotinin Sigma Aldrich A1153 0.5 mg/mL 0.5 μg/mL Storage:  
–20°C 
Working: 4°C 

Benzamidine Sigma Aldrich 12072 0.5 mg/mL 0.5 μg/mL Storage:  
–20°C 
Working: 4°C 

BL21(DE3) 
Competent E. 
coli cells 

New England 
Biolabs 

C2527H NA NA –80°C 

Bradford Assay 
Kit  

ThermoFisher 
Scientific 

23236 NA NA 4°C 

Bromophenol 
blue 

Sigma Aldrich B0126 100% 0.1% RT 

Coomassie 
stain, Bio-
Safe™ 

BioRad 1610786 100% 100% RT 

Dimethyl 
sulfoxide 
(DMSO) 

Sigma Aldrich D8418 NA NA RT 
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Item Supplier Catalogue 
# 

Stock 
conc. 

Working 
conc. 

Storage 
temp. 

Dithiothreitol 
(DTT) 

Biobasic DB0058 1 M Various Stock:  
–20°C 
Working: RT 

Ethanol (EtOH) Fisher 
Scientific 

P06EAAN 100% 20% (v/v) RT 

Glutathione Sigma Aldrich G4251 NA 20 mM 4°C 
Glutathione 
Sepharose bead 
slurry 

GE Healthcare 
Life Sciences 

17075605 NA NA 4°C 

Glycerol Fisher 
Scientific 

G33-1 100% Various RT 

Glycine Wisent 
Biosciences 

800-045-IK NA 192 mM RT 

GST-α-
synuclein 
plasmid, human 

NA NA 100 ng/μL 2 ng/μL –20°C 

GST-3C plasmid NA NA 100 ng/μL 2 ng/μL –20°C 
GST-α-
synuclein 
plasmid, mouse 

NA NA 100 ng/μL 2 ng/μL –20°C 

Isopropyl-β-D-
thiogalactoside 
(IPTG) 

Biobasic IB0168 0.5 M 300 µM Stock:  
–20°C 

LAL 
chromogenic 
endotoxin 
quantification 
kit† 

Thermo 
Scientific 

88282 NA NA 4°C 

LB broth (Miller) BioShop LBL407 NA 25 g/L RT 
Leupeptin Sigma Aldrich L2884 0.5 mg/mL 0.5 μg/mL Stock:  

–20°C 
Working: 4°C 

Methanol 
(Certified ACS) 

Fisher 
Scientific 

A412-1 100% 40% RT 

Paraform-
aldehyde (PFA) 

Thermo Fisher 28908 100% 4% RT 

Phenylmethane-
sulfonyl fluoride 
(PMSF) 

Sigma Aldrich P7626 0.5 M 5 mM Storage:  
–20°C 
Working: 4°C 

Phosphate-
buffered saline 
(PBS) 

Wisent 
Bioproducts 

311-012 10x 1x RT 

Protein 
molecular 
weight 
standards 

BioRad 1610373 NA NA –20°C 

SOC medium New England 
Biolabs 

B9020S NA NA RT or 4°C 
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Item Supplier Catalogue 
# 

Stock 
conc. 

Working 
conc. 

Storage 
temp. 

Sodium chloride 
(NaCl) 

Wisent 
Bioproducts 

600-08 NA 400 mM Working: 4°C 

Sodium dodecyl 
sulfate (SDS) 

Wisent 
Bioproducts 

800-100 10% Various RT 

Tetramethyl-
ethylene-
diamine 
(TEMED) 

BioShop TEM001.50 100% Various 4°C 

Tris-HCl Wisent 
Bioproducts 

600-126 Various Various RT 

Triton X Sigma Aldrich X100 20% 0.5% Stock: RT 
Working: 4°C 

*Light-sensitive reagent. Stock and working aliquots should be covered in aluminum foil to minimize 
exposure to light. 
†The LAL chromogenic endotoxin quantification kit contains components that are light-sensitive in 
lyophilized form (LAL and chromogenic substrate). Light-sensitive components should be covered to 
minimize exposure to light. 

 

2.3 Equipment 
Item Supplier Catalogue # 

ÄKTA pure L protein 
purification system 

GE Healthcare Life Sciences 29018224 

Beckman Coulter Avanti J-
25I centrifuge (with JLA-
10.500 and JA-25.50 rotors) 

Beckman Coulter BE-J25 

BioDrop DUO 
Spectrophotometer 

BioDrop 80-3006-61 

Bioruptor® Plus sonication 
device with metallic 
soundproof box (B01200001) 
and water cooler 
(B02010003) 

Diagenode B01020001 

CPXH Series Ultrasonic 
Cleaning Bath 

Fisher Scientific  15-336-126 

Digital heating shaking 
drybath or thermomixer 

ThermoFisher Scientific 88880027 
Eppendorf 2231000574 

Ecotron Incubation Shaker 
(with cooling) 

INFORS HT Ecotron 

Fisherbrand Model 120 Sonic 
Dismembrator with sound 
enclosure box 

Fisher Scientific NA 

Getinge Castle Vacuum 
Gravity Steam Sterilizer 
(autoclave) 

Getinge 700HC-E SERIES 

Heating block Eppendorf 5383000027 
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Item Supplier Catalogue # 

Infinite® 200 PRO series 
plate reader 

Tecan INF-MPLEX 

Low-speed orbital shaker Corning LSE 6780-FP 
New Brunswick Innova 42 
incubator shaker 

Eppendorf M1335-0010 

Nutating Mixer VWR 8207-202 
PowerPac Universal Power 
Supply 

BioRad 1645070 

Reciprocal shaking bath Precision™ NA (discontinued) 
Stirrer plate VWR 97042-706 
Temperature-controlled 
orbital shaker 

Barnstead MaxQ 

Thermo Scientific Heraeus 
Megafuge 40R Refrigerated 
Centrifuge 

Fisher Scientific 75004518 

UNICORNTM 7.0.2 software GE Healthcare Life Sciences 29115456 
Vortex mixer Corning LSE 6776 
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3 Protocol 

3.1 Expression and purification of GST-α-synuclein and GST-3C enzyme 
Materials: 

• BL21 (DE3) competent E. coli cells 
• Plasmid(s): 

– Human GST-α-synuclein expression plasmid (100 ng/μL) 
– Mouse GST-α-synuclein expression plasmid (100 ng/μL) 
– GST-3C enzyme expression plasmid (100 ng/μL) 

• SOC medium 
• Ampicillin (100 mg/mL) 
• 125-mL Erlenmeyer flasks 
• 2-L Erlenmeyer flasks 
• 500-mL capped polypropylene bottles 
• 50-mL capped polypropylene bottles 
• 50-mL tubes 
• 0.2-μm sterile syringe filter and 22G 1½” sterile needle 
• 10- or 20-mL disposable chromatography columns 
• Support stand and column holder 
• Amicon Ultra-15 Centrifugal Filter Unit 
• Parafilm 
• IPTG (0.5 M) 
• 1x PBS 
• 20% EtOH in ddH2O 
• Glutathione sepharose bead slurry 
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• Solutions: 

Solution Components 

LB medium (autoclaved) • 1 L ddH2O 
• 25 g LB broth 

Resuspension buffer (80 mL; prepare fresh 
and chill on ice before use) 

• ddH2O 
• 25 mM Tris, pH 8 
• 400 mM NaCl 
• 5% glycerol  
• 0.5% Triton X 
• 5 mM PMSF 
• 0.5 mg/mL benzamidine 
• 0.5 µg/mL leupeptin 
• 0.5 µg/mL aprotinin 
• 1 mM DTT 

Wash buffer (500 mL; chill on ice) • ddH2O 
• 50 mM Tris, pH 8 
• 400 mM NaCl 
• 5% glycerol 
• 1 mM DTT (add fresh before use) 

Elution buffer (20 mL; prepare fresh and chill 
on ice before use) 

• Wash buffer 
• 20 mM glutathione (once dissolved adjust 

pH to 8) 

 

• LB agar plates containing 100 μg/mL ampicillin (see Appendix 4.4 for procedure) 
• SDS-PAGE and gel staining materials (see Appendix 4.8 for procedure) 
• Bradford Assay kit and materials (see Appendix 4.6 for procedure) 
• 42°C water bath 
• Temperature-controlled orbital shaker 
• 37°C bacterial incubator 
• Beckman Coulter Avanti J-25I centrifuge with JLA-10.500 and JA-25.50 rotors 
• Spectrophotometer and cuvettes 
• Fisherbrand Model 120 sonic dismembrator 
• Bioruptor Plus sonicator 
• Thermo Scientific Heraeus Megafuge 40R Refrigerated Centrifuge 
• Nutating mixer 
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Procedure (for each plasmid): 

1. Thaw vial of BL21 (DE3) competent E. coli. cells on ice for 10 minutes. 
2. Add 1 µL (100 ng) of plasmid to the cells and gently flick the tube 4 to 5 times to mix. 

Incubate cells on ice for 30 minutes. 

• Do not vortex cells to mix. 

3. Place cells in a 42°C water bath for 10 seconds. Transfer cells to ice and incubate for 5 
minutes. 

4. Add 950 µL of SOC medium to the cells. Shake cells at 200 rpm at 37°C for 1 hour. 

• During the incubation, warm LB-ampicillin agar plates to 37°C. 

5. Spread 20 µL of cells onto warm LB-ampicillin agar plates and incubate plates at 37°C 
overnight. 

6. Add 20 mL of LB medium to a 125-mL Erlenmeyer flask. Add ampicillin to the medium to a 
final concentration of 100 µg/mL. 

7. Use a sterile 20 µL pipette tip to pick a single, isolated colony from the plate and eject it into 
the flask containing the LB medium. Shake culture at 200 rpm at 37°C overnight. 

• Plates with colonies can be stored at 4°C for up to 1 month. For long-term storage of 
transformed bacteria, prepare a glycerol stock (see Appendix 4.5 for procedure). 

8. Add 500 mL of LB medium to each of four 2-L Erlenmeyer flasks. Add ampicillin to the 
medium in each flask to a final concentration of 100 µg/mL. 

• Larger flasks may be used if available as long as the volume of medium is appropriate for 
the flask size (e.g. 2 L of LB medium in one 8-L flask). 

9. Transfer 5 mL of overnight culture to each of the 2-L flasks containing the LB medium. 
Shake at 200 rpm at 37°C and 200 rpm. Monitor the optical density at 600 nm (OD600) until it 
reaches 0.6 (see Appendix 4.7 for procedure). 

• It usually takes 3 to 5 hours or longer for the OD600 to reach 0.6. 

10. Add IPTG to the culture to a final concentration of 300 µM to induce protein expression. 
Reduce shaker temperature to 16°C and shake culture at 200 rpm at 16°C for 18 hours 
(overnight). 
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11. Divide the culture among six 500-mL polypropylene bottles, ensuring that all filled bottles are 
of equal weight. Close bottles with caps and centrifuge at 5000 G at 4°C for 30 minutes 
using a JLA-10.500 rotor. 

• Place each bottle into a canister, and then place each canister into a cavity in the JLA-
10.500 rotor. 

• Place the rotor lid on top of the rotor and fasten the round knob securely into the 
centrifuge. 

12. Remove the supernatant and resuspend each pellet with 20 mL of cold resuspension buffer. 
Combine the culture and divide into four 50-mL capped polypropylene bottles, ensuring that 
both filled bottles are of equal weight (approximately 30 mL per bottle). 

• If necessary, the supernatant may be stored at –80°C until ready to sonicate. Once the 
frozen supernatant has been thawed, proceed immediately to the next step. 

13. Sonicate the cells on an ice bath using the sonic dismembrator on the following settings: 5 
cycles; 30 seconds ON/30 seconds OFF, 60% power. 

14. Close bottles with caps and centrifuge at 18,000 rpm at 4°C for 30 minutes using the JA-
25.50 rotor. 

15. After the lysates have been cleared by centrifugation, transfer the supernatant from each 
bottle into 50-mL tubes. 

16. To check the expression of GST-α-synuclein, reserve 100 μL of the supernatant (cleared 
lysate) for analysis on a 14% polyacrylamide SDS-PAGE gel (see Appendix 4.8 for 
procedure). 

• Recombinant GST-α-synuclein will run at approximately 40 kDa on a 14% polyacrylamide 
SDS-PAGE gel (Figure 2). 
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Figure 2. 14% polyacrylamide SDS-PAGE gel of recombinant GST-α-synuclein (GST-α-syn) in BL-21 cell 
lysate control (BL-21 –IPTG) and in BL-21 cell lysates induced with IPTG (BL-21 +IPTG). 

 

17. Add 5 mL of glutathione Sepharose 4B bead slurry to two clean 50-mL tubes. Wash the 
beads by adding 30 mL of ddH2O to each tube, centrifuge at 3000 rpm at 4°C for 3 minutes 
and remove liquid. 

18. Wash the beads by adding 30 mL of cold wash buffer to each tube, centrifuge at 4°C at 
3000 rpm for 3 minutes and remove liquid. Repeat this step two more times. 

19. Pass the cleared lysates (from step 16) through a 0.2-µm sterile syringe filter into the 2 
tubes containing the washed glutathione sepharose beads. Cap the tubes, seal with 
Parafilm, and incubate on a nutating mixer at 4°C for at least 24 hours. 
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20. Set up six 10-mL disposable chromatography columns in the column holders on the support 
stand. Place a vessel (e.g. beaker) under each column to collect flow-through. Transfer the 
lysate-bead mixtures to the columns. With the column stopcocks open, wash beads five 
times with 5 mL of cold wash buffer. 

• The beads will be retained in the column, while the liquid will flow through the columns. 

21. Close the column stopcocks and place 50-mL tubes under the column to collect eluents. 
22. Add 3 mL of cold elution buffer to each column and incubate for 10 minutes. Slightly open 

the column stopcocks and allow the eluents to drip into the 50-mL tubes. Repeat this step 
three more times. 

• The beads can be re-used to purify the same protein. Wash the columns containing the 
beads three times with 5 mL wash buffer then rinse three times with 5 mL ddH2O. Add 
20% EtOH to the column so that the beads are covered, and then transfer the bead 
solution to a clean 50-mL tube. Beads can be stored at 4oC until the expiry date on 
product label. 

23. Combine the eluents and transfer to a single Amicon Ultra-15 Centrifugal Filter Unit. 
Centrifuge at 4000 xG at 4°C for 30 minutes. 

24. Add 10 mL of PBS and centrifuge at 4000 xG at 4°C for 30 minutes. Repeat this step three 
times to concentrate the eluent to ≤4 mL. 

25. Determine the protein concentration (see Appendix 4.6 for procedure). 
26. Proceed immediately to Section 3.2 to cleave the GST tag off from the GST-α-synuclein. 

Reserve 20 µL of GST-α-synuclein to analyze by SDS-PAGE (see Section 3.2, step 9). 
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3.2 Cleavage of GST-α-synuclein and purification of untagged α-synuclein 
Materials: 

• Recombinant GST-α-synuclein protein 
• Recombinant GST-3C enzyme 
• 1.5-mL microcentrifuge tubes 
• 96 deepwell plate 
• Amicon Ultra-15 Centrifugal Filter Unit 
• Superdex 200 16/600 column 
• GSTrap 4B column 
• Support stand and column holder 
• SDS-PAGE and gel staining materials (see Appendix 4.8 for procedure) 
• 1x PBS 
• 20% EtOH in ddH2O 
• Solutions: 

Solution Components 

Wash buffer (500 mL; chill on ice) • ddH2O 
• 50 mM Tris, pH 8 
• 400 mM NaCl 
• 1 mM DTT (add fresh before use) 

Elution buffer (20 mL; prepare fresh and 
chill on ice before use) 

• Wash buffer 
• 20 mM glutathione (once dissolved adjust 

pH to 8) 

 

• Bradford Assay kit and materials (see Appendix 4.6 for procedure) 
• Thermo Scientific Heraeus Megafuge 40R Refrigerated Centrifuge 
• Ultrasonic cleaning bath 
• ÄKTA pure L protein purification system with UNICORN 7.0.2 software 
• LAL chromogenic endotoxin quantification kit and materials (see Appendix 4.10 for 

procedure) 

Procedure: 

1. Add GST-3C protease to GST-α-synuclein at a 1:50 mass-to-mass ratio. Place the reaction 
mixture at 4°C overnight. 

• For example, add 0.3 mg of GST-3C protease to 15 mg of GST-α-synuclein. 
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2. Equilibrate a GSTrap 4B column connected to a 30-mL Luer Lok syringe. Place a vessel 
(e.g. beaker) under the column to collect flow-through. Wash column with 20 mL of ddH2O to 
remove EtOH, and then wash with 20 mL of PBS. 

3. Reserve 20 µL of the overnight reaction mixture to analyze by SDS-PAGE. Inject the 
remaining mixture into the GSTrap 4B column and collect the flow-through in a 50-mL tube. 
This is synuclein with GST-tag removed. 

• The column can be re-used to purify the same protein. Wash the column with 10 mL of 
cold elution buffer, then 10 mL of ddH2O, and then 10 mL of 20% EtOH. Store at 4°C until 
the expiry date on the product label. 

4. Transfer the synuclein to an Amicon Ultra-15 Centrifugal Filter Unit. Centrifuge at 4000 xG at 
4°C for 30 minutes to concentrate to ≤4 mL. Reserve 20 µL of the sample to check synuclein 
purity on SDS-PAGE. If there are still some minor impure bands found, repeat step 2 to 
remove remaining GST or go further to steps 5 to 8 to remove other impurities.   

5. Prepare filtered, sonicated PBS for the ÄKTA pure L system by passing 500 mL of PBS 
through a 0.2-µm sterile disposable filter unit and then sonicating for 3 minutes using an 
ultrasonic cleaning bath. 

6. Start equilibration of the Superdex 200 16/600 column on the ÄKTA pure L system. The 
equilibration takes approximately 11 hours and should be run overnight so that the system is 
ready for the samples the next day. See Appendix 4.9 for instructions to set up and run the 
equilibration using the UNICORN software.  

7. Purify the concentrated eluent with the Superdex 200 16/600 column on the ÄKTA pure L 
system. Run a sample method to fractionate the sample into a 96 deepwell plate, and then 
run a cleaning method to clean the column. See Appendix 4.9 for instructions to set up and 
run the sample and cleaning methods using the UNICORN software. 

• The sample method takes approximately 2 hours to run. 
• IMPORTANT: The column must be cleaned immediately after running the sample. The 

cleaning method takes approximately 15 hours to run. 

8. Transfer the combined desired sample fractions to an Amicon Ultra-15 Centrifugal Filter 
Unit. Centrifuge at 3000 rpm at 4oC for 10 to 15 minutes. 
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9. To check the purity of the untagged α-synuclein, run a 14% SDS-PAGE gel alongside the 
3C cleavage reaction (from step 3) and GST-α-synuclein (from Section 3.1; see Appendix 
4.8 for procedure). 

• Recombinant untagged α-synuclein will run at approximately 15 kDa on a 14% 
polyacrylamide SDS-PAGE gel (Figure 3). The calculated molecular weight of α-
synuclein is 14.87 kDa based on its amino acid sequence. 

 

Figure 3. 14% polyacrylamide SDS-PAGE gel of GST-tagged α-synuclein (GST-α-syn), 3C protease 
cleavage of the GST tag (3C cleavage), and purified untagged α-synuclein (α-syn). 

 

10. Determine the synuclein concentration, adjust to 5 mg/mL with sterile PBS (see Appendix 
4.6 for procedure), and sterile passing 0.22 µm filter. Prepare 500 µL aliquots in 1.5-mL 
autoclaved microtubes and store at –80°C. Reserve 1 aliquot determine endotoxin levels 
(next step). 

• Depending on the downstream application, other aliquot volumes may be preferred (e.g. 
20 µL, 50 µL). 

• Aliquots should be labelled with the batch number, name of protein, protein 
concentration, and date. 

11. Determine the endotoxin concentration of reserved aliquot (see Appendix 4.10 for 
procedure). 

• When using this protocol, the endotoxin concentration is typically 100 to 1000 EU/mg of 
protein when α-synuclein is produced in BL-21 cells, or <100 EU/mg of protein when α-
synuclein is produced in ClearColi cells. 
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3.3 Generation of α-synuclein PFFs 
Materials: 

• Recombinant monomeric α-synuclein (500-µL aliquot; 5 mg/mL) 
• Parafilm 
• 37°C digital heating shaking drybath or thermomixer 
• Bioruptor Plus sonicator 

Procedure: 

1. Seal the 500-µL aliquot of monomeric α-synuclein with Parafilm. Incubate in a 37°C digital 
heating shaking drybath or thermomixer at 1000 rpm for 5 days. 

2. Sonicate the PFFs on the following settings: 10 cycles, 30 seconds ON/30 seconds OFF, 
high power, 10°C water circulation. 

• Ensure that the tube holder is balanced with tubes containing equal volumes. 

3. Depending on the downstream application, prepare 20- to 100-μL aliquots of PFFs in 1.5-mL 
tubes and store at −80°C. 
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3.4 Fluorescent labelling of α-synuclein PFFs 
Materials: 

• α-synuclein PFFs 
• 1.5-mL tubes 
• Aluminum foil 
• Slide-A-Lyzer dialysis device and 50-mL conical tube 
• Alexa-488, Alex-568, and/or Alexa-633 fluorescent dye (5 mg/mL in DMSO) 
• 1x PBS 
• Bradford Assay Kit and materials (see Appendix 4.6 for procedure) 
• Orbital shaker at 4°C 

Procedure: 

1. Add 5 µL of a fluorescent dye to 150 µL of α-synuclein PFFs and mix gently. Cover samples 
with aluminum foil to protect from light and incubate at room temperature for 20 minutes. 

• IMPORTANT: Do not vortex PFFs. 
• Incubation time may vary depending on the dye. Refer to the incubation time 

recommended by the manufacturer. 

2. Add 1 mL of PBS to a dialysis device placed in the 50-mL conical tube. Let sit for 5 minutes 
to ensure the membrane does not leak (replace the dialysis device if leaking). Empty the 
dialysis device and remove from the tube. 

3. Add 45 mL of PBS to the tube. Add the dye-PFFs mixture to the dialysis device and place 
the dialysis device in the tube. Cap the tube, place on the orbital shaker at 4°C, and shake 
at 150 rpm for at least 2 hours. 

• Ensure the membrane of the dialysis device is submerged in the PBS. 

4. Remove the dialysis device from the tube to discard the PBS. Add 45 mL of fresh PBS to 
the tube and replace the dialysis device. Cap the tube, place on the orbital shaker at 4°C, 
and shake at 150 rpm for at least 2 hours. 

5. Collect the labeled PFFs from the dialysis device. Prepare 20- to 50-μL aliquots in tube and 
store at –80°C. Reserve an aliquot of labelled PFFs to determine the protein concentration. 

• IMPORTANT: Store all aliquots of labelled PFFs at –80°C before determining protein 
concentration of reserved aliquot. Do not store PFFs on ice or at 4°C, as this causes 
dissociation and reduces activity. 
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4 Appendix 

4.1 Human GST-α-synuclein plasmid 
The plasmid used to express human GST-α-synuclein is pGEX-6-alpha synuclein (backbone 
plasmid: pGEX6P1) and was originally purchased from the University of Dundee MRC Protein 
Phosphorylation and Ubiquitination Unit (#DU30005). 

Map of pGEX-6-alpha synuclein: 
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Sequence of insert: 

GGATCTATGGATGTATTCATGAAAGGACTTTCAAAGGCCAAGGAGGGAGTTGTGGCTGCT
GCTGAGAAAACCAAACAGGGTGTGGCAGAAGCAGCAGGAAAGACAAAAGAGGGTGTTCTC
TATGTAGGCTCCAAAACCAAGGAGGGAGTGGTGCATGGTGTGGCAACAGTGGCTGAGAAG
ACCAAAGAGCAAGTGACAAATGTTGGAGGAGCAGTGGTGACGGGTGTGACAGCAGTAGCC
CAGAAGACAGTGGAGGGAGCAGGGAGCATTGCAGCAGCCACTGGCTTTGTCAAAAAGGA
CCAGTTGGGCAAGAATGAAGAAGGAGCCCCACAGGAAGGAATTCTGGAAGATATGCCTGT
GGATCCTGACAATGAGGCTTATGAAATGCCTTCTGAGGAAGGGTATCAAGACTATGAACCT
GAAGCCTAAGCGGCCGC 

 

Properties of recombinant human α-synuclein (untagged): 

Amino acid sequence GPLGSMDVFMKGLSKAKEGVVAAAEKTKQGVAEAAGKTKE
GVLYVGSKTKEGVVHGVATVAEKTKEQVTNVGGAVVTGVT
AVAQKTVEGAGSIAAATGFVKKDQLGKNEEGAPQEGILEDM
PVDPDNEAYEMPSEEGYQDYEPEA* 

Molecular weight 14,871.61 DA 
Theoretical pI 4.67 

 

4.2 Mouse GST-α-synuclein plasmid 
The plasmid used to express mouse GST-α-synuclein was created in the laboratory of Dr. 
Edward Fon (Montreal Neurological Institute, McGill University) by cloning the complete coding 
sequence for mouse α-synuclein into the pGEX6P1 backbone plasmid. The insert was 
generated by GeneArt® Life Technologies (construct #15AB4CPC). 

Please refer to the plasmid map in Appendix 4.1 for details on the pGEX6P1 backbone 
plasmid. 
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Sequence of insert: 

GGATCCATGGACGTGTTCATGAAGGGCCTGAGCAAGGCCAAAGAGGGCGTGGTGGCCGC
TGCCGAAAAGACCAAGCAGGGCGTGGCCGAGGCCGCTGGCAAGACAAAAGAGGGGGTG
CTGTACGTGGGCAGCAAAACAAAAGAAGGCGTGGTGCACGGCGTGACCACCGTGGCCGA
AAAGACAAAAGAACAGGTCACAAACGTGGGCGGAGCCGTGGTGACAGGCGTGACAGCTG
TGGCCCAGAAAACCGTGGAAGGCGCTGGCAATATCGCCGCTGCCACCGGCTTCGTGAAG
AAAGACCAGATGGGCAAGGGCGAGGAAGGCTACCCCCAGGAAGGCATCCTGGAAGATAT
GCCCGTGGACCCCGGCAGCGAGGCCTACGAGATGCCCAGCGAAGAGGGCTACCAGGACT
ACGAGCCCGAGGCCTGACTCGAGCGGCCGC  

 

Properties of recombinant mouse α-synuclein (untagged): 

Amino acid sequence GPLGSMDVFMKGLSKAKEGVVAAAEKTKQGVAEAAGKTKE
GVLYVGSKTKEGVVHGVTTVAEKTKEQVTNVGGAVVTGVTA
VAQKTVEGAGNIAAATGFVKKDQMGKGEEGYPQEGILEDM
PVDPGSEAYEMPSEEGYQDYEPEA 

Molecular weight 14,896.68Da 
Theoretical pI 4.74 
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4.3 GST-3C plasmid 
The plasmid used to express GST-3C protease was created by cloning the coding sequence for 
human rhinovirus (HRV) 3C protease into the pGEX-2T backbone plasmid. 

Map of pGEX-2T-3C: 
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Properties of recombinant HRV 3C protease (untagged): 

Amino acid sequence AFRPCNVNTKIGNAKCCPFVCGKAVTFKDRSTCSTYNLSSS
LHHILEEDKRRRQVVDVMSAIFQGPISLDAPPPPAIADLLQSV
RTPRVIKYCQIIMGHPAECQVERDLNIANSIIAIIANIISIAGIIFVI
YKLFCSLQGPYSGEPKPKTKVPERRVVAQGPEEEFGRSILK
NNTCVITTGNGKFTGLGIHDRILIIPTHADPGREVQVNGVHTK
VLDSYDLYNRDGVKLEITVIQLDRNEKFRDIRKYIPETEDDYP
ECNLALSANQDEPTIIKVGDVVSYGNILLSGNQTARMLKYNY
PTKSGYCGGVLYKIGQILGIHVGGNGRDGFSAMLLRSYFTG
QIKVNKHATECGLPDIQTIHTPSKTKLQPSVFYDVFPGSKEPA
VLTDNDPRLEVNFKEA 

Molecular weight 44351.97 
Theoretical pI 8.50 
Extinction coefficient 23100 M-1 cm-1, at 280 nm measured in water (assuming all 

pairs of Cys residues form cystines) 
 

4.4 Preparation of LB-ampicillin agar plates 
Materials: 

• 1-L glass bottle with cap 
• Petri dishes 
• LB broth 
• Agar 
• Ampicillin (100 mg/mL) 

Procedure: 

1. Add 12.5 g LB broth and 7.5 g agar to the 1-L glass bottle. Add ddH2O to the bottle to make 
a total volume of 500 mL and autoclave on the liquid cycle. 

2. After the autoclave cycle is complete, allow the LB agar medium to cool to approximately 
42°C. Add 500 μL of ampicillin (final concentration of 100 μg/mL) and mix well. 

3. Immediately pour the LB-ampicillin agar medium into the Petri dishes (approximately 20 mL 
per dish). Let the plates sit undisturbed at room temperature for 30 minutes to allow the 
medium to solidify. 

4. Transfer the plates into a sealed bag and store at 4°C. 
 

4.5 Preparation and recovery of bacterial glycerol stocks 
Materials: 

• Overnight bacterial culture 
• 50% glycerol in ddH2O 
• LB agar selection plate (containing appropriate antibiotic) 
• 37°C bacterial incubator 
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Procedure: 

1. Add 500 µL of bacterial culture to 500 µL of 50% glycerol in a cryovial. Mix gently. Store at –
80°C. 

2. To recover bacteria from the stock, use a 200 µL tip to scrape the surface of the frozen 
solution and streak onto a warm LB agar selection plate. Store the remaining stock at –
80°C. Incubate plate at 37°C overnight. 

• Do not allow the glycerol stock to thaw during handling. 

3. Colonies on a plate may be used to grow a bacterial culture. 
 

4.6 Measurement of protein concentration using Bradford Assay Kit 
Materials: 

• Bradford Assay kit 
• Albumin Standard (BSA) 
• Samples of unknown concentration 
• Blank solution (sample solvent) 
• 1.5-mL microcentrifuge tubes 
• Clear 96-well plate 
• Coomassie Reagent 
• Infinite 200 PRO series plate reader 

Procedure: 

1. Prepare standards by diluting the contents of 1 Albumin Standard (BSA) ampule into several 
clean microcentrifuge tubes (2000 µg/mL–25 µg/mL). 

2. Pipette 5 µL of blank, standard, or unknown sample in duplicate into a clear 96-well plate. 

• Blanks should be run in duplicate. 

3. Add 250 µL of the Coomassie Reagent to each well and mix properly. Incubate plate for 10 
minutes at room temperature. 

4. Measure the absorbance at 595 nm using a plate reader. 
5. Subtract the average measurements for the blank duplicates from all other individual 

standards or sample measurements. 
6. Prepare a standard curve by plotting the average blank-corrected measurement for each 

BSA standard versus its concentration in µg/mL. Use the standard curve to determine the 
protein concentration of each unknown sample. 
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4.7 Measurement of optical density 
Materials: 

• LB medium 
• Bacterial culture 
• Spectrophotometer and cuvettes 
• Samples of unknown optical density 

Procedure: 

1. Add 1 mL of LB medium to a disposable polystyrene spectrophotometer cuvette. 
2. Place cuvette in spectrophotometer and measure the absorbance at a wavelength of 600 

nm. This is the blank measurement. 
3. Add 1 mL of bacterial culture to another cuvette and measure the absorbance at a 

wavelength of 600 nm. 
4. Subtract the blank absorbance value from the sample absorbance value to find the optical 

density. 
 

4.8 SDS-PAGE and gel staining 
Materials: 

• Protein samples 
• Protein molecular weight standard 
• Gel casting module (casting stand, casting frame, comb, short plate, spacer plate) 
• Filter paper 
• 100% EtOH 
• Tetra cell (electrode assembly, tank, lid with power cables, buffer dam) 
• PowerPac 
• Coomassie stain solution 
• Orbital shaker 
• Solutions: 

Solution Components 
4% stacking gel solution (15 
mL) 

• 1.98 mL of 30% acrylamide/bis-acrylamide 
• 3.78 mL of 0.5 M Tris-HCl, pH 6.8 
• 150 µL of 10% SDS 
• 9 mL ddH2O 
• 15 µL TEMED (add just before pouring gel) 
• 75 µL of 10% APS (add just before pouring gel) 
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Solution Components 
14% separating gel solution 
(15 mL) 

• 7.0 mL of 30% acrylamide/bis-acrylamide 
• 3.75 mL of 1.5 M Tris-HCl, pH 8.8 
• 150 µL of 10% SDS 
• 4.03 mL ddH2O 
• 7.5 µL TEMED (add just before pouring gel) 
• 75 µL of 10% APS (add just before pouring gel) 

4x SDS loading buffer • 200 mM Tris 
• 8% SDS 
• 40% glycerol 
• 0.4% bromophenol blue 
• 400 mM DTT 
• Dilute to 1x when preparing loading samples 

10x SDS-PAGE running 
buffer 

• ddH2O 
• 1% SDS 
• 250 mM Tris 
• 1.92 M glycine 
• Dilute 1:10 to prepare a 1x solution 

Destain solution • 50% ddH2O 
• 40% Methanol 
• 10% Acetic acid 

 

Procedure: 

1. Assemble glass cassette sandwich in the casting frame and secure on casting stand. 
2. Add 10% APS and TEMED to the separating gel solution and fill the cassette sandwich up 

to the point that will be approximately 1 cm below the teeth of the comb when inserted. 
Overlay the gel solution with 100% EtOH. Leave separating gel undisturbed for 45 to 60 
minutes to allow polymerization. 

3. Pour off the alcohol overlay and rinse the top of the gel with ddH2O. Dry the area above the 
gel with filter paper. Partially insert the comb between the glass plates. 

4. Add 10% APS and TEMD to the stacking gel solution and fill the cassette sandwich. Insert 
the comb completely. Leave stacking gel undisturbed for 30 to 45 minutes to allow 
polymerization. 

5. Remove the comb and rinse wells ddH2O. 
6. Prepare protein samples in 1x SDS loading buffer so that 1 µg to 5 µg of protein in a volume 

of 10 μL to 20 μL can be loaded per well. 
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7. Set the electrode assembly to the open position on a clean, flat surface. Place the gel 
cassette in the electrode assembly. 

• Two cassettes are required to create a functioning assembly. When using one or three 
gels, use the buffer dam (included with the cell) to complete the assembly. 

8. Place the assembly into the tank. Fill the buffer chambers with 1x SDS-PAGE running 
buffer. 

• Approximately 200 mL of buffer is required for the inner buffer chamber and 
approximately 550 mL (for 1–2 gels) or 800 mL (for 3–4 gels) in the outer buffer chamber. 

9. Remove the comb from the gel to allow the sample wells to fill with running buffer. 
10. Gently load 5 μL of protein ladder into the first well from the left. Load the remaining wells 

with 10 to 20 μL of samples. 
11. Secure the lid on the tank and connect the power cables to the PowerPac. Set the power 

supply to constant voltage at 150 V. Run gel for approximately 1.5 hours or until the loading 
dye front and/or molecular weight standards reach the desired position on the gel. 

12. Disassemble the gel apparatus. Open the gel cassettes and transfer the gel to a container 
containing 50 mL ddH2O. Place the container with the gel on an orbital shaker set to 50 rpm 
and wash for 5 minutes. Discard the wash. Repeat this step 2 more times. 

13. Add 30 mL of Coomassie stain solution to the gel. Shake until the blue protein bands 
become visible (approximately 30 minutes). 

14. Discard the stain solution and rinse gel with ddH2O. 
15. Add 50 mL destain solution to the gel. Shake until the gel background is clear and only the 

blue protein bands are visible (2 hours to overnight). 
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4.9 Instructions for using UNICORN 7.0.2 software on the ÄKTA pure L 
protein purification system 

1. Turn on the ÄKTA pure L system and open the UNICORN software. 
2. In the Administration window, under the Tools menu, select Method Editor from the 

Tools menu. 

 

3. Create a new method to equilibrate the Superdex 200 16/600 column. 

• In the Method Editor window, select the New Method icon  or by selecting New 
Method from the File menu. 
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• In the New Method window, select Gel Filtration (GF) under Predefined Method and 
then select OK. A Method Navigator window will open. 

 

• In the Method Navigator window, select Method Settings and then enter the 
parameters shown in the image: 
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• In the Method Navigator window, select Equilibration and then enter the parameters 
shown in the image: 

 

• In the Method Navigator window, select Elution and then enter the parameters shown 
in the image: 
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• Save the method with unique file name. 

4. Run the equilibration method. 

• Place line A1 into a flask containing ddH2O and line B1 into a flask containing filtered, 
sonicated PBS. Seal the tops of the flasks with Parafilm. 

• In the Administration window, open the System Control from the Tools menu. 

 

• In the System Control window, select Open from the File menu. The Method Navigator 
window will open. 
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• In the Method Navigator window, select your equilibration method. Select Start to run 
the method. The method takes approximately 11 hours to run (can be run overnight). 

 

• Switch line A1 from the flask containing water to the flask containing PBS. 
• In the System Control window, right-click on the A in the Process Picture. Select Start 

pump A wash to fill the line with PBS. 

 

5. Create a new method to run the sample. 

• In the Method Editor window, select the New Method icon  or by selecting New 
Method from the File menu. 

• In the New Method window, select Gel Filtration (GF) under Predefined Method and 
then select OK. A Method Navigator window will open. 
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• In the Method Editor window, select Methods Settings and then enter the parameters 
shown in the image: 

 

• In the Method Editor window, select Equilibration and then enter the parameters shown 
in the image: 
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• In the Method Editor window, select Sample Application and then enter the parameters 
shown in the image: 
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• In the Method Editor window, select Elution and then enter the parameters shown in the 
image: 

 
 

• Save method with a unique file name. 

6. Run the sample method. 

• Place a 96 deepwell plate in the fraction collector. 
• Clean the sample loop by injecting 10 mL of ddH2O, and then prime the sample loop by 

injecting 10 mL of PBS. 
• Inject the sample. 
• In the System Control window, select Open from the File menu. The Method Navigator 

window will open. 
• In the Method Navigator window, select your sample method and rename the file name 

to the sample name. Select Start to run the method. The method takes approximately 2 
hours to run. 
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7. In the Evaluation window, visualize the sample fractionation. Collect and combine all 
fractions from the desired peak. 

• In the example shown below, fractions D1–D11 should be collected. 

 

8. Create a new method to clean the column. 

• In the Method Editor window, select the New Method icon  or by selecting New 
Method from the File menu. 

• In the New Method window, select Gel Filtration (GF) under Predefined Method and 
then select OK. A Method Navigator window will open. 
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• In the Method Editor window, select Methods Settings and then enter the parameters 
shown in the image: 
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• In the Method Editor window, select Equilibration and then enter the parameters shown 
in the image: 
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• In the Method Editor window, select Elution and then enter the parameters shown in the 
image: 

 

9. Run the cleaning method. 

• Place line A1 into the flask containing ddH2O and line B1 into 20% EtOH. 
• Clean the sample loop by injecting 10 mL of PBS, then 10 mL of ddH2O, and finally 10 

mL of 20% EtOH.  
• In the Systems Control window, select Open from the File menu. The Method 

Navigator window will open. 
• In the Method Navigator window, select your cleaning method and rename the file name 

to the date. Select Start to run the method. The method takes approximately 15 hours to 
run. 
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4.10 Measurement of endotoxin concentration using LAL chromogenic 
endotoxin quantification kit 

Materials: 

• LAL chromogenic endotoxin quantification kit 
• Sample of unknown concentration 
• 25% acetic acid (Stop Reagent) 
• 1.5-mL microcentrifuge tubes 
• Clear 96-well plate 
• Infinite 200 PRO series plate reader 
• Heating block at 37°C 
• Vortex mixer 
• Timer 

Procedure: 

1. Reconstitute the vial of Endotoxin Standard by adding 1 mL of room temperature endotoxin-
free water. Vortex the solution vigorously for at least 15 minutes on a vortex mixer before 
use. 

• The amount of the Endotoxin Standard is printed on the vial label (endotoxin units [EU]). 
For example, a vial of 26 EU, when reconstituted with 1 mL of endotoxin-free water, will 
yield a concentration of 26 EU/mL. 

• Reconstituted stock solution is stable at 2°C to 8°C for up to 4 weeks. Prior to 
subsequent use, warm the solution to room temperature and vigorously mix for 15 
minutes (endotoxin adheres to sides of the glass vial). 

2. Prepare standards by diluting the reconstituted Endotoxin Standard in endotoxin-free water 
in several clean microcentrifuge tubes (1 EU/mL–0.1 EU/mL). 

• Vigorously vortex each standard for at least 1 minute before use. 

3. Reconstitute the LAL reagent immediately before use by adding 1.4 mL of endotoxin-free 
water. Swirl gently to dissolve the powder. 

• Avoid foaming; do not vortex the solution. 
• If more than one vial is required, pool two or more vials before use. 
• Reconstituted LAL reagent is stable at –20°C or colder for up to 1 week if frozen 

immediately after reconstitution. Thaw to room temperature and gently swirl the reagent 
to mix before adding to samples. Once thawed, the reagent may be used only one time 
and cannot be refrozen. 
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4. Reconstitute the Chromogenic Substrate by adding 6.5 mL of endotoxin-free water. 

• Reconstituted Chromogenic Substrate is stable at 2°C to 8°C for up to 4 weeks. Prior to 
use, warm up the appropriate volume of substrate solution required for the assay to 37°C. 

5. Place the 96-well plate on the heating block for 10 minutes to equilibrate to 37°C. 
6. Pipette 50 µL of blank (endotoxin-free water), standard, or unknown sample in duplicate into 

the plate wells. 
7. Add 50 µL of LAL reagent to each well and start the timer. Remove the plate from the 

heating block and gently tap to mix. Replace the plate on the heating block and cover with 
the lid. Incubate for 10 minutes. 

8. When the timer reaches 10 minutes, add 100 µL of Chromogenic Substrate to each well. 
Remove the plate from the heating block and gently tap to mix. Replace the plate on the 
heating block and cover with the lid. Incubate for 6 minutes. 

• Add the Chromogenic Substrate in the same well order and with the same speed as the 
LAL reagent was added. 

9. When the timer reaches 16 minutes, add 100 µL of Stop Reagent to each well. Remove the 
plate from the heating block and gently tap to mix. 

10. Measure the absorbance at 405 to 410 nm using a plate reader. 
11. Subtract the average measurements for the blank duplicates from all other individual 

standards or sample measurements. 
12. Prepare a standard curve by plotting the average blank-corrected measurement for each 

endotoxin standard versus its concentration in EU/mL. Use the standard curve to determine 
the endotoxin concentration of each unknown sample. 
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